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Part B    The lexicon handling capabilities

9. Basic data structures.

While maclex has very few limitations on parameters, one that you may run into is that 
reversal mode assumes a maximum of 300 fields in an input record, more are allowed but 
would be ignored for reversal purposes. (This could be increased if users find it too 
limiting.) Lexicon mode and sorting have no limit on the maximum number of fields in a 
record. Each record must not exceed 32kb in size.

The basic data structures are the following:
a. the file,
b. the record,
c. the subrecord,
d. the group,
e. the field,
f. the field's token (SIL people will know this as a 'standard format marker')
g. the token's prefix (ie. its first character) - for SIL people this will be \

To review these briefly: the field is comprised of an initial token which the user can define, 
say, \1 for the first field of a record (ie. the 'header' field). While the generic tag, which we 
will hereafter call a token, can be anything (as long as it does not exceed 7 characters), in 
actual practice it is recommended that each token begin with a unique character that will 
never appear elsewhere in any file, and then be followed with up to 6 characters of the 
user's choosing. 

The reason for this is that MacLex's lexicon and reversal functions require that every token 
begin with a unique1 character which will appear nowhere else in any file of lexicon data. 
The SIL organisation has adopted the backslash character ( \ ) for this purpose, and 
MacLex uses it as the default in dialogs. You are free to use another if you wish. We shall 
call this special character the token prefix character.

The other thing about tokens is that for reversals a token may not exceed a total of 7 
characters, including the token prefix. Examples of acceptable tokens, in SIL's "standard 
format" would be  \1   \2   \exampl   \ft   \gram  and so forth. (Lexicon handling and sorting 
can 

1MacLex uses this character to analyse a record into its fields when doing reversals; so if 
you have it in other places besides the start of tokens, MacLex might break up records the 
wrong way. MacLex cannot do reversals properly if every token does not start with the 
same (unique) character.
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1. What is MacLex? 2
accept longer tokens.) When doing a reversal, any token longer than 7 characters will have 
the end clipped to a maximum of 7. You would be wise to limit tokens to a maximum of 7 
characters, and then MacLex will always perform properly.

Following a token there comes a single2 character to separate the token from the field's 
data. We call this character a delimiter. It can be a space, a tab, or a carriage  return. 
Space is easy to work with. If you have tokens of varying length, you may prefer to use a 
tab. Everything following the delimiter up until the next token is treated by MacLex as data. 
It is acceptable, and makes for easy reading of the screen, if every field is terminated by a 
carriage return; however, this is not obligatory. Blank lines between records are fine, but 
totally unnecessary.

MacLex recognises some larger groupings. Part A has dealt with files, records and fields. 
Part B introduces some more groupings intermediate between records and fields. One is 
the subrecord, another is the group. Both of these are relevant mostly to the reversal 
process, so will be dealt with in detail later. Basically, a subrecord is a group of fields which 
starts with a unique field type3 specified by you. A group is a (typically smaller) group of 
fields which also starts with a unique field type nominated by you. There can be several 
groups in a subrecord or record4; and more than one type of group is allowed within a 
single record or subrecord.

2It is important that you realise that only the first character after a token is the token's 
delimiter. If, say, you typed two spaces following tokens, then only the first would be taken 
as the delimiter, and MacLex would think the second space was part of the field's data. If 
you typed two spaces after  the token in each record's header field, then in lexicon mode 
when MacLex goes to look at the first data character of each header it would find a space 
every time - and when it constructs buttons on the left of the screen using the initial 
character it would use a space, with the result that the button would look empty, and there 
would only be one button for the whole lexicon instead of one per alphabetical division. So, 
if you want to type several spaces or tabs after a token, then be sure to tell MacLex to 
'ignore' them for sorting purposes
3By 'field type' we mean a field with a certain token, which you can specify. Every field's 
type is defined by the token which starts it. A token acts like a name or label, and you can 
label your data however you please. For example, you might use \ms  as a label for data 
which is the 'meaning sense' of a vernacular word; or \ps as a label for a 'part of speech', of 
\ex to begin a field containing an example of a vernacular work in context, and so forth.
4A record is really just the first subrecord of one or more subrecords. The record must have 
a header token different from a subrecord's header token in order to know when new 
records begin. And the fact that a subrecord, if it occurs, will have a different header means 
that when sorting records the subrecords get 'carried long for the ride'.
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10. Preparing your lexicon files, and resizing files.

Preparation needs to be done only once. Thereafter you can load your lexicon files at at will 
without further preparation. Preparation is simple. The output of a sort operation done by 
MacLex gives you data files ready for use by the lexicon handling features.

If you have not used MacLex before, then you need to know and or do the following things:

a. decide what your special sorting order is to be, if you want one. Default is English 
alphabetical order (for the buffs, that means "ascii order").

b. decide if certain characters in your data are to be ignored, for sorting purposes, and 
decide on which ones.

c. decide on an approximate file size for your lexicon files; shorter ones make MacLex 
work faster - in the range 5 to 20 kilobytes is a good size. Larger sizes would be okay 
for faster computers. Smallish files make MacLex's file handling seamless, and except 
for this fact file sizes are unimportant.

d. use your decision on c. to estimate how many files to tell MacLex to make when sorting. 
For example: if our lexicon is about 600kb, and you want 6kb files, then you would want 
about 100 files5.

e. at the desktop, create another folder to hold any control files MacLex will need from time 
to time. You can put this folder anywhere, but a good place  for it is inside6 the folder you 
created at step e.

f. start up MacLex, open a New file and type in your special sorting order if you intend to 
use one. Save it in the folder created at step e. - give it a  name which clearly tells you 
what it's for.

g. similarly, make a separate file containing any characters you want ignored when sorting, 
and save it in the same folder7 as contains your file having your special sorting order

h. Close the editing window and  using the results of these steps sort your dictionary files 
using the Automatic filenames option. (You must use automatic filenames; it's the only 
way to control the output file sizes.)

You have finished the preparation stage.

5The actual number is irrelevant; MacLex can work with any size or number. The only affect 
file size has is that longer files take longer to read off the disk, and longer to save. With files 
of about 5-20 kb disk accesses become completely 'invisible' (if you have a hard disk). With 
faster machines like the SE/30 or the II series, larger files could be used.
6See Part A for an explanation of the rationale for doing this.
7Later, you can place your definition file/s for doing reversals in this folder too, and likewise 
for any other control files used in your lexicon work.
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Note  1: In the lexicon's folder there should only be (a) your lexicon files, and , if you wish, 
(b) other folders8.

Note  2: MacLex updates files as necessary by overwriting them. No backups are created.

Because of this, before beginning a session you could do a Duplicate (at the desktop) of 
the folder of lexicon files, if you want a backup.

As your lexicon grows, the file sizes will expand as MacLex puts more records in them. 
Eventually they might grow so large that you start to notice a deterioration in the 
responsiveness of MacLex. When this happens it is time to resize the files.

To do this just sort your lexicon files with the Automatic filenames option on, and increase 
the number of output files - doubling the quantity would be a good idea. When sorting is 
finished you are ready to go again. You can do this as often as you like. 

8MacLex ignores any folders it finds mixed in with your files. It just uses whatever files it 
finds and assumes they contain lexicon data.
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11. Lexicon mode

To open a lexicon for a work session choose Load Lexicon... from the Lexicon menu. The 
following dialog will come up.

Most of the features of this dialog should be familiar. Running through them quickly...

(i) Sort key token.
This token is the one which starts the first field of every record. It is the token that MacLex 
looks for in order to break up a file's data into records. The field which has this as its token 
is called the record's header. The default is \w, but you can set it permanently to anything 
you like using the Preferences... dialog. MacLex uses the data in each record's header field 
to construct a 'sort key' which defines that record's place in the ordered list of records 
comprising the lexicon.

(ii) Key length.
This tells MacLex how many characters can be used for a sort key. The default value of 16 
is adequate for most needs. If short on memory you might shorten it to about 10. 
Unnecessarily long keys achieve nothing except wasting memory space. You can increase 
the value to a maximum of 32.
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(iii) Ignore data in ( parentheses ).
If this box is checked then MacLex will check the beginning of each record header (and 
only the header) for an opening parenthesis. If it finds one, it will ignore everything up till 
and including the matching closing parenthesis when constructing a sort key. What follows 
the closing parenthesis is what is used. If there is no matching closing parenthesis (maybe 
you forgot to type it) then it will use whatever follows the opening parenthesis to construct a 
key.

For example, in the Djinang language, reflexive verbs are preceded by a particle inydji. I 
want the following stem to be used for constructing the sort key, so I would type such a 
header9 as follows:
\1 (inydji )birrindjingilgi
The sort key will then be based on birrindjingilgi.

(iv) Special sorting order, and Ignore these characters when sorting boxes.
In the first of these you can type your special sorting order, if you use one. Ignore it if you 
are content with default (English) order. How to define a special order is fully covered in the 
documentation of MacSort.

In the second box you can type those characters you want MacLex to ignore when it 
constructs sort keys in order to place records in correct sequence. Things you might type 
here are characters like space, hyphen, inverted comma, etc. if they appear10 in headers 
and are not important for sorting purposes. For more details, see the MacSort 
documentation.

(v) Locate Lexicon Files... button.
When you press this a standard input file dialog comes up. Use it to go to the folder where 
your lexicon files reside. "Open" any one of the lexicon files in that folder (by double clicking 
it, or pressing the Open button). This does not actually open that file; instead, it tells 
MacLex which folder has the lexicon files. There will be a short delay while MacLex scans 
the folder and prepares a list of all the files which it uses subsequently for all file handling. 
You can press this button more than once. What folder of files gets used when you are 
ready to begin is whatever one you specified last.

(vi) Get Order... button.
This is a shortcut to help you get your special sorting order into the large text box. If you 
have saved your order in a text file, you  can use 

9MacLex has a built in capability to remove the parentheses in certain circumstances, such 
as when reversing, or when exporting.
10Beware, do not ask MacLex to ignore a character which is part of the orthographic system 
of the vernacular - this might cause loss of contrast of some phonemes and hence records 
not always in the order you expect.
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this button to locate that file. The button puts up a standard file dialog. When you click the 
Open button, the file's data is written to the dialog's text box. If you open the wrong file, just 
press the Get Order... button again and locate the right one. MacLex does not use the 
contents of the special sorting order text box until you press the Begin button.

(vii) Get Ignores... button.
This works just like the Get Order... button, but fills the "Ignore these characters when 
sorting" text box with the contents of the file you open.

(This button and the one above it are repeated as menu items in the File menu, but are not 
accessible there while the dialog is up.)

(viii) Begin button.
When you are finished with the dialog, pressing Begin sets the loading operation going and 
sets up the screen for interactive manipulation of your lexicon. The dialog below will come 
up after the files are scanned and an index table prepared in memory.

(ix) Cancel button.
Press this if you choose not to go ahead with your session.

Certain settings will be 'remembered' even though you have cancelled. For example, if the 
two large text boxes have text in them, it will be there in these boxes (or their equivalents in 
other dialogs) if this or other dialogs are opened later. Likewise, if you have typed a 
different header token, it will be remembered and be used as the default in other dialogs. If 
you want to restore everything to their defaults quickly, choose the Restore Defaults item 
in the Sort menu - it restores everything except the special sorting order and any 
characters to be ignored when sorting. To clear a special sorting order, just drag across it 
and press the backspace key. Similarly the "Ignore these characters when sorting" text box.
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12. Lexicon display

After the index table has been prepared, MacLex will create the following kind of display. It 
is your working environment for interactively manipulating your lexicon data.

Note: the appearance of the screen in the current version may differ slightly from the above 
because features have been added or changed.

It will help us to have a few names for the things on the screen. The box on the left we will 
call the divisions box, and it contains a number of buttons each of which corresponds to 
one alphabetical division (or partition11) of your lexicon.

The box at the bottom we will call the command bar, it has arrow keys for going forward or 
back, a text box for typing a header for MacLex to search for, some buttons for adding, 
deleting and editing records, and a few other things as well. In version 1.0 and higher, the 

11The partitioning of your lexicon into alphabetical divisions is a wholely automatic feature of 
MacLex, you don't need to concern yourself with it. 
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record number is displayed at the far right - and the edit text box shortened to make space 
for it.

The window will display whatever record is 'current', and on entering this mode this will be 
the first record of your lexicon. The display shows records as they are in the disk files. A 
Format feature (selectable on the Lexicon menu) is planned for implementation at a later 
time. It will allow you the option of having records displayed in formatted form without their 
tokens, etc. Editing, however, will always be done with the unformatted 'raw' data. 

MacLex automatically adjusts the size of the windows to whatever are the dimensions of 
your main screen. It also adjusts to menu bars of nonstandard height.

If you have your lexicon loaded at this point, you can play with the buttons and see what 
they do quicker than I can tell you about them. For those who like to read about it first, here 
is what they do...

12.1 The Divisions buttons.

As MacLex scans your files to prepare its index table, it also checks out the sort keys to 
see what they start with - as modified by whatever sorting order you have specified. Every 
time a previously unrecognised initial character is encountered, MacLex notes the fact and 
works out whether or not it corresponds to a digraph, trigraph, or whatever. Whatever it 
corresponds to is displayed as one button in the divisions box. There will be as many 
buttons as there are alphabetical divisions in your lexicon - up to a maximum of 72 buttons 
(in four columns) for small screen Macs, and for Macs with larger screens, up to 108 
buttons.

The buttons are displayed in whatever font is current, and MacLex will reduce the font size 
used for the button names if you need lots of buttons - and hence smaller ones. As you 
enter records in your lexicon, if a record's header begins with a character (or digraph, etc)  
which MacLex did not previously encounter, then it creates a new button12 and updates all 
the buttons to reflect the new situation. Similarly if you 

12This behaviour is a common source of (apparent) error in MacLex's behaviour. If you have 
a lexicon sorted using an order defined by yourself, and especially if it contains digraphs or 
multigraphs, and you load the lexicon while forgetting to specify the order you used earlier, 
then MacLex won't know about the digraphs or multigraphs, and what usually happens is 
that you will get very many divisions buttons, and some will have the same names. Don't do 
any editing or adding of new records when this has happened. Exit the lexicon, and reload 
using the correct sorting order. Another common (apparent) error is a blank button - this 
occurs if the header field's data starts with a white space character, such as a space or a 
tab.
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delete the last record in a division, the number of buttons is reduced and the display 
updated.

What do the buttons do? Their purpose is to allow to you navigate quickly about your 
lexicon. Pressing a button puts up a list of all the headers which begin with the character or 
characters comprising the buttons 'name'. You can scroll the list to find the header you 
want, and double clicking it will dispose of the list and leave you with that record showing 
on the screen. If you change your mind and don't want to go to another record, then just 
click outside the list and it will go away. So, for example, clicking the ng button for my 
Djinang lexicon would show the following list, and if I (single) click on any line it is selected, 
as follows:

The list may be inhibited if you prefer a press of a divisions button to merely send you to 
the first record in a division. This is selectable in the Preferences dialog which we will 
discuss later.

12.2 The Command Bar

The   Tag   button  .
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This allows you to invisibly 'mark' a record as the one you want to return to later on.

The   Back   button.  

This allows you to return immediately to whatever record was last tagged. At the same 
time, whatever record you were at when you pressed the Back button becomes the tagged 
record. Therefore, continually pressing the Back button will toggle you back and forwards 
between those two records.

The   View   button  .

It gives a scrollable display of the records in the immediate context, one record per line (as 
much of it as can fit) omitting the tokens. This is called 'view mode'. You cannot enter, 
delete, or edit records while in view mode; but you do still have access to the Preferences 
dialog.

To scroll the display, press one of the two 'wedge' buttons13 in the middle of the command 
bar. To exit from view mode, click on the window.

Which fields get displayed for viewing can be set in the Preferences dialog. If you don't 
specify which ones, or use the 'view these fields only' checkbox to turn the feature off, 
MacLex will display every field starting from the first.

The Preferences dialog also allows you to have MacLex drop into view mode automatically 
when you type a header in the command bar and that particular record does not exist. This 
gives immediate visual feedback on the lexicon's contents in the area where the searched 
for record would have been had it been present.

The   Delete   button.  

Deletes a record instantaneously, without any annoying "Do you want to delete this record" 
messages. (There is provision to undelete when you make a  mistake.)

The   New   button.  

13These buttons will also later be used for scrolling the display when the Formatted menu 
item is implemented.
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This blanks the window, activates it for editing, and allows you to type in a new record. 
When done, just click outside14 the window and your record will be entered into the lexicon 
and its file updated on the disk. Or you can press the Enter key instead - handy if you don't 
want to have to take your hands off the keyboard to grab the mouse.

If the window is empty when you exit it (ie. you typed no record), nothing is entered in the 
lexicon. This is quite safe to do. If you are using a template, and you type nothing, MacLex 
no longer requires you to dispose of two consecutive warning messages when you exit 
using the Enter key.

MacLex will check the header's token, and alerts you if it finds an error condition. You will 
then be given opportunity to correct it.

I intend (provided I don't forget) to provide an option whereby MacLex will check every 
token in the new record against a list of tokens supplied by you (or compiled by MacLex 
automatically), and alert you if it finds one which is new. That should catch most typing 
mistakes. It will be selectable from the Preferences dialog. Default will be to have the check 
turned 'on'.

There is one difference between clicking outside of the window to leave it, and typing Enter 
to do the same thing. Doing the latter leaves you in 'new record' mode with a blank screen 
ready for another record to be typed. This saves you from having to grab the mouse and hit 
the New button every time you want to type a record. If you want to use the Enter key to 
leave off entering new records altogether, just type it twice in succession.

Remember, it does not matter what record happens to be on the screen when you hit New. 
MacLex works out where to place each record that you type and does so, updating the 
relevant file. When you finish off entering records, you are left with the last one showing on 
the screen - so that's where you will be in the lexicon at that time.

Finally, the four small boxes, one of which will be black, allow you to control which template 
to use with the New command, from the command bar. Click on the top box to use the first 
template, the second to use the second template, etc. The bottom box turns off the use of a 
template.

14Beware where you click. If you click over a button, the button will respond immediately. 
This is probably not what you would want. Click over the text box at the right of the 
command bar to exit without initiating some other action. Or you can use this to advantage; 
for example, click an arrow to exit from the editing window and also go to the next record.
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The   Edit   button.  

This button allows you to make changes to existing records.

If you want to enter editing mode to change a record, and do not want to have to grab for 
the mouse, there is an Edit Record menu item on the Edit menu. It has a command 
euivalent of Command + E. Typing Comand E, or clicking the menu item using the mouse, 
has the same effect as clicking the Edit button in the command bar.

Like the New button, you can use either the Enter key to leave off editing a record, or you 
can click outside the window. Either way is effective; however using the Enter key does not 
leave you in editing mode. To edit a series of records, you have to explicitly perform an 
action to gain access to each record in order to edit them. This may be a little tedious, but it 
is good protection against accidental changes or erasures.

You will note that you are unable to make the window active for editing by clicking on it. You 
have to press the button, choose the menu  item, or type its command equivalent to gain 
access to a record.

The wedge buttons
The up and down wedge buttons have a function in lexicon mode. When a record is so 
large that it extends below the bottom of the window, you can click on these buttons to 
scroll the display up or down - it moves 10 lines at a time. 

One last thing. The three buttons New, Delete and Edit, are the only ones which initiate 
updates of your lexicon files on the disk. If the unthinkable happens and your screen 
suddenly shows garbage, don't panic, all is well with your lexicon files provided you don't 
use one of these buttons. Just immediately choose Exit Lexicon on the Lexicon menu and 
all will be well. (Then you can safely choose Load Lexicon again and continue with your 
session.)

The 'next' and 'previous' arrows.

These hardly need comment. Press them to go forward or back to the next record. Hold 
them down to zip along really fast. When you come to the end of the lexicon, MacLex just 
wraps you to the beginning; or if you are going backward, it wraps you to the end. To alter 
the buttons' responsiveness, the Preferences dialog allows you to specify a delay, 
measured as a number of 'ticks' (one tick equals 1/60th of a second). A value of about 5 is 
recommended. A 0 value gives you maximum speed of response.
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The left and right cursor keys on the keyboard also activate the 'previous' and 'next' arrows 
of the command bar, respectively.

The command bar text box.

If you want to go straight to the record with a given known header field, type the header and 
when you hit the carriage return key MacLex will search for it in its internal index table. If 
found it will appear on the screen.

If MacLex cannot find it, then it will beep. What record is showing on the screen after this 
will depend on the settings in the Preferences dialog. Default15 is that you will be not moved 
elsewhere in the lexicon, the current record will remain on the screen. Alternatively, you can 
have MacLex go to the record which immediately precedes where the nonexistent one 
would have been; or you can have it go to the record which immediately follows where the 
nonexistent one would have been, or you can have it drop into view mode.

If you type a number in the box, MacLex will go to the record which has that number. The 
first record is numbered 1. If you type a number bigger than however many records are in 
the lexicon, MacLex will go to the last record. Typing zero or a negative number has the 
same  effect as typing 1.

15You can change this default setting using the Preferences... dialog.
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12.3 The Preferences menu item.

Choosing Preferences... from the Lexicon menu will bring up something like the following 
dialog.

We have discussed the function of the radio buttons for what to do when a search for a 
typed header fails to locate a record with that header.

We have also discussed the effect of the radio buttons at the top right for suppressing or 
allowing the list of headers to come up when a divisions button is pressed.

At the middle top right are boxes which show the current settings for the "token prefix" and 
the (input) record's header field's token. The token prefix is especially relevant for the 
reversal process, and it is discussed in detail there. If you reset either or both of the 
contents of these boxes, then whatever you type there will come up in other dialogs - those 
for sorting, loading the lexicon, or reversing your lexicon.
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MacLex allows you to specify up to three "templates" of tokens, including the delimiting16 
character after each token. The buttons below the text boxes allow you to turn off the use of 
all templates, or alternatively, to choose one of them. Whether the dialog comes up with 
something in the template boxes or not will depend on whether you have previously saved 
one or more templates using the Save Settings button - see below.

If a template is in effect, then every time you type the New button to enter a new record, the 
template is placed in the window and the cursor is positioned after the first token. Using a 
template is a handy way to avoid mistyping tokens. The more regular your record structure 
is, the more useful a template will be to you.

The text box at the top middle allows you to set the repeat rate for the 'next' and 'previous' 
arrow keys on the command bar, in units of 1/60th of a second.

The text box at the middle right allows you to specify one or more tokens for the fields that 
you want MacLex to display when in view mode. The checkbox immediately above allows 
you to turn this feature on or off. If not checked, then MacLex will just display every field in 
a record, going through the record in top to bottom order, displaying as many fields as the 
screen width will allow.

Below the text box the current font's name is displayed. This cannot be changed from within 
the dialog. To change it you must exit the dialog first.

The Semanatic Category Options... button brings up a dialog for setting various options 
related to how many levels of categories to use, the name of the token to use for each 
level, and what kind of category data is to be written to records. Discussion of this button 
and a picture of the dialog is reserved till section 26.

This dialog has some empty space on it for other options to be added as I add further 
functions to MacLex.

At the bottom right is a Save Settings button. Pressing this button will make all the settings 
currently showing in the dialog become 

16The use of carriage return as a delimiter is not supported when typing a template into the 
dialog. The dialog uses a typed carriage return to start a new line in the dialog's text box. If 
users are not happy with this then let me know. It would be possible to instead have the 
boxes run across the dialog and have any carriage return typed as a token's delimiter show 
in the dialog as a space. But I doubt if users will use carriage return as a delimiter, and if 
that is the case then the vertical display is nicer.
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permanent (or at least until you change them again with another Save Settings button 
press).

The Get Settings... button allows you to input a new set of preferences from a previously 
saved preferences file, at any time.

These buttons bring up a standard file dialog, allowing you either to name the preferences 
file and store it wherever you like - with the other control files would be wise; or to select the 
preferences file to be input, depending on which button you pressed. (Earlier versions of 
MacLex stored preference data in the program file itself, which was an annoying limitation if 
you wanted to use the one program to handle different lexicons - each with a unique set of 
preferences. Now you can change preferences at will.)
12.4 Recovering Deletions

Every time you press the Delete button in the command bar, whatever record is currently 
on the screen gets immediately deleted and its file is updated. There are two ways to 
recover the deleted record if you change your mind.

Way One
If the record you want to recover is the last one deleted, then you can choose the Undo 
Deletion menu item in the Edit menu. The record will be immediately reinserted in its 
correct place and its file updated on the disk.

Way Two
If you have deleted several records, and then want to restore one deleted much earlier, 
then select the Recover Deletions... menu item on the Edit menu. The appearance of the 
screen will be similar to the following:
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The record showing in the window will be the first in a list of formerly deleted ones. MacLex 
remembers the records you delete, up to a maximum of ten. After that, each new deletion 
goes on the list and the earliest stored deletion is then permanently lost. This allows you to 
restore, at any time, up to ten17 of your earlier deletions.

To restore a record, use the arrow buttons to get it showing on the screen and then press 
the Restore button, or hit carriage return. The To First and  To Last buttons take you to 
the first or last records in the list. The last record in the list is the earliest one you deleted, 
and is the next candidate for permanent loss when your deletions exceed ten.

Deletions stay in the list until either they are displaced by new deletions, or you choose the 
Exit Lexicon menu item.

The repeats text box allows you to specify how many times MacLex is to insert the 
diplayed record when you hit the Restore button. Default is one time.

17It would not be hard, nor use much space to remember more than ten, if that is what users 
want. I feel that ten is enough protection. Let me know if you disagree.
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If you want multiple copies of a record placed in your lexicon, then change the number to 
the number of identical records you want. If you have to enter a number of nearly identical 
records, then type the first record, delete it, and then replace it repeatedly using the 
repeats facility. At the end of the replacements, you will see the last replacement on the 
screen. You can then work back through the inserted records editing each according to 
your requirements18.

18Another way to accomplish the same thing is to type a record using New, and then select 
all of it and Copy it; then hit the Enter button to get a new blank window and Paste it there, 
and then change it to what you want. Repeat the last few steps for as many records as you 
need.
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